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THE ROCHAMBEAU 
LIBRARY HAS A NEW 
PHONE NUMBER! 

  
401.272.3780 

ON THE WEB: 
Visit us at  
www.friendsofrochambeau.org 

Friends of Rochambeau 
708 Hope Street 
Providence, RI 02906 
friend@friendsofrochambeau.org 
 

Letter from the 
President 
By Chris Suchmann 

This year we have seen a lot of change. 
Change in the economy, change in 
government and change in our library 
system. 
 
The Providence Community Libraries 
have a new Director and a new mission. 
To their credit, you may not have 
noticed that anything is different. 
Service has remained excellent. 
The most important feature of the new 
Providence Community Libraries is that 
they are all remaining open!  Thank you 
Ellen, Linda, Marcus, Patricia et al. ! 
 
We invited PCL director Ann Robinson  
to our December board meeting to give 
us a sense of her vision for the new 
“community libraries”. Her hope is that 
each library will reflect the character of 
the surrounding neighborhoods and 
become a community center where 
people can congregate, and  among 
other things, share knowledge, stories, 
music and their different cultural 
traditions. 
 
At Rochambeau, we are very fortunate 
to have this “community”  already! 
Our hope and our mission is to continue 
to support Tom, his staff and all of the 
great programs at our beloved library. 
We also plan to support the larger 
mission of the PCL and reach a hand 
out to our other Community Libraries  
to develop a thriving citywide library 
system. 
 
I hope you enjoy this edition of our 
newsletter. June Tow introduces our 
new and exciting board members, and 
Gil Mason brings us up to speed with 

our extremely successful semi-annual 
book sale. 
All this and some exciting upcoming 
events! So read on….. 
 
Oh yes, and don’t forget to remember us 
during 2010. All contributions to the 
Friends of Rochambeau are much 
appreciated and tax deductible. 
 
Sincerely, 
 
Chris Suchmann 
(Doyle Ave.)◘ 

 
Fall Book Sale a 
Resounding Success 
By Gil Mason 

Fall Book Sale Report : In spite of the 
terrible economic conditions, in spite of 
the loss of half of our book dealers 
through business failures, the fall book 
sale was a success. 
 
A net result of more than $6,000 was 
made possible through the magnificent 
efforts of a dedicated team of sorters, 
cashiers, handlers, publicists, set-up 
crews, and others too numerous to list. 
also, the great cooperation of Librarian 
Tom and his Rochambeau people 
was invaluable. 
 
  The sale ran for a full week early in 
October.  The first night was dealers 
night. the second was "Friends" night. 
The final four days were open to the 
public, with two at regular prices ($1.00 
for books and audio-visuals and $.50 for 
all children's materiel) and the last two 
at $5.00 per grocery bag full. 
 
More than forty volunteers participated 
in the sale.   (Continued on Page 2) 
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BOOK SALE (CONTINUED) 
We are now looking forward to the 
spring sale in April 2010, when with the 
help of our terrific team and the support 
of all the "Friends" we expect another 
winner for our library. ◘ 

widths and spacing, use the Columns 
command o♦ ♦ ♦ the Format menu. 

 
DVD DRIVE 
UNDER WAY! 
The Friends of Rochambeau Library are 
seeking donations of gently used DVDs 
to add to the library collection. This is 
an opportunity to help the library, other 
patrons and yourself. By donating your 
DVDs to the library, others will have a 
chance to enjoy them and you will 
continue to have access to them as well. 
Until we hace drop boxes in place, 
please leave them at the circulation 
desk. ◘ 

change. On the Format menu, click 

Columns. Select the Line Between 
check box.  

Creating a Heading that Spans 
Columns 
If your text isn't already formatted in 
columns, create the columns. In page 
layout view, select the heading text. 
Choose Columns from the Format 
menu, and then click One. 

Forcing the Start of a New Column  
Click where you want to start the new 
column. On the Insert menu, click 
Break. Click Column Break. Word 
moves the text that follows the insertion 
point to the top of the next column. 

Balancing Column Length 
If your text is not already formatted in 
columns, create the columns. In page 
layout view, click at the end of the 
columns you want to balance. On the 
Insert menu, click Break. Click 
Continuous. Word inserts a continuous 
section break, which balances the text 

equally among the columns. 

If you want to force a new page to start 
after the balanced columns, click after 
the continuous section break and then 
insert a manual page break.  

Removing Columns 
If your document is divided into 
sections, click in the section or select 
multiple sections you want to change. 
Choose Columns from the Format 
menu, and then click One. 

Formatting Text 
Boxes 
Type your sub-heading here 
Your By-line 

 

WELCOME NEW BOARD MEMBERS! 
             by June Tow, 2009 Nominating Chair 
 
The Friends of Rochambeau Library welcome six new board members (David Berman, Jenny Fierro, Neeltje Henneman, Hildburg 
Herbst, Douglas Itkin and Steven Lagasse) to an already dynamic group. 
 
David Berman  is a retired professor of mathematics at the University of New Orleans. He graduated from Dartmouth and received 
his doctorate from the University of Pennsylvania. David volunteers at the Miriam Hospital and enjoys his photography class at 
CCRI. 
 
Jenny Fierro is a librarian at Hope High School who previously worked at Brown. Jenny received her degree from the University of 
Puerto Rico and her M.S in Library Science from the University of Illinois.  As a mother of three, Jenny is hopeful "that the young 
adults will use the resources of the Rochambeau Library" 
 
A graduate of Amherst College, Neeltje Henneman hails from Lexington, Kentucky.  She is in her second year as the head of the 
Upper School at Wheeler School.  Neeltje was Dean of the Faculty at the St. Ann's School in Brooklyn, NY. With what little spare 
time she has, she enjoys reading, knitting, quilting and bicycling. 
 
Hildburg Herbst received her PhD from Princeton and is a professor emerita at Rutgers University where she taught German 
languages and literature. She describes herself as "the intrepid book sorter." 
 
Douglas Itkin is the Website Quality Assurance team manager at American Power Conversion.  He graduated from the University of 
Rochester.  Doug is also active in the Summit Neighborhood Association. His two children are frequent Library users. 
 
Steven Lagasse serves as Legal Counsel for American Power Conversion in West Kingston.  He attended George Washington 
University and Roger Williams University School of Law.  Steven is very well versed in local and national politics.    ◘ 
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Library Hours 
 

Monday & Thursday  
1:00 pm - 9:00 pm 

 
Tuesday & Wednesday  

9:30 am - 6:00 pm  
 

Friday & Saturday  
12:00 - 6:00 pm 

Brother Can You 
Spare A Book? 
By Chris Suchmann 

Last December Whole Foods Market 
sponsored an event called “Holiday of 
Giving” They collected food 
donations for the Whole Kids Food 
Bank, warm clothing for Amos 
House, spare change for the RI Good 
Neighbor Energy Fund and books 
for the Rochambeau Library.  

We were asked to come down to the 
store and speak with people about 
Rochambeau Community Library, the 
great work that it does in our 
community and how the book 
donations help support our effort.  We 
enjoyed many conversations, made 
some new Friends and received 
several boxes of books, which I 
assured them would be put to good 
use. 

CHECK THIS OUT! 
 
Read an original vignette from local 
long-time Friend Mark Binder.  Go 
to www.friendsofrochambeau.org! 

Save a Tree! 
 
If you’d like to receive your Friends 
newsletters via email, sign up at 
www.friendsofrochambeau.org!  
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Spring Book Sale 
Just Around the 
Corner! 
The annual Friends of Rochambeau 
Spring Book Sale is coming up very 
soon.  Mark down the dates below, and 
as always, please consider lending a 
hand!  Sign-up sheets will be located at 
the front desk.  
  
April 15-17: Set up 
April 19: Dealers Night 
April 20: Friends 
April 21-22: Public 
April 23-24th: $5 a bag 
April 26th: Non-profits (free) 
April 27th: Breakdown.  
 
To volunteer, call Gil at 401.447.4369◘ 

LIMERICK 
CONTEST!!! 

It’s time for our annual limerick 
contest!  Anyone can write a 
limerick!  Why not give it a try?  

One entry ONLY per person in 
each age group. 

Limericks may be humorous, 
serious, political, or newsworthy. 

Please print legibly or type your 
limerick on the computer and 
then attach a printed copy to the 
entry form, which you can find 
at the front desk. 

Limericks with foul language will 
be discarded. 

ALL entries must be submitted at 
the library by 9pm on March 10.  
Then join us for the Limerick 
Contest Party on March 18! 

Helpful limerick-writing tips: 
 

• Anyone can write a 
limerick! 

• Good limericks tell 
stories 

• Limericks have five lines 
• Lines 1, 2, and 5 rhyme 

and are longer (usually 9 
syllables) 

• Lines 3 and 4 rhyme with 
each other and are shorter 
(usually 5 syllables) 

• A good last line is 
important and should 
have a bit of a punch 
 

First place and runner-up prizes 
will be awarded to each of the 
following age groups:  0-9, 10-17, 
18-69, and 70+  ◘ 
 

 

Upcoming 
Events at the 
Library: 
Thursday 2/11 7pm 
Darwin Day Celebration 
The Galapagos Islands: 174 Years 
After Darwin 
 
Thursday 2/25 7pm 
Jazz @ Rochambeau 
The Mike Miller Swingtet with 
Special Guest 
 
Saturday 3/6 1pm – 4pm 
Friends Volunteer Gala 
 
Thursday 3/18 6pm – 9pm 
Friends of Rochambeau Limerick 
Contest and Blarney Bash 
 
Monday 3/8 7pm 
Dr. Lynn Lazarus Serper, EdD  -- 
Learning is a Rich and Essential 
Fuel for the Brain               ◘ 

 

Brother Can You Spare 
a Book? 
(Continued from Page 2) 

Thomas Lane was in the store 
hawking his mother, Helen 
Hudson’s book, Dinner at Six, a 
collection of intimate and often heart 
wrenching conversations with some 
of the people that she met while 
working in a soup kitchen.  Thom 
has been touring the country and 
selling the book to raise money for 
agencies that are helping to feed and 
clothe people who are in need. He 
was a great conversationalist and 
stayed in town long enough to 
introduce Eileen Hayes, at her 
presentation at Rochambeau 
Community Library the following 
Thursday evening.  

Eileen, as many of you know, has 
been the director of Amos House 
for nine years. Her presentation 
titled “New Faces of Homelessness 
and Hunger in Rhode Island” was 
as compelling as Ms. Hudson’s book 
and was a gentle wake up call to us 
all: 

“But for the grace of God, there go 
I” 

These human beings are as much a 
part of our community as anyone 
and need our love and support.  
Whether it’s a sympathetic shoulder, 
some hot soup or a free book! If you 
want to help you can start by buying 
a copy of Helen Hudson’s book.  
One hundred per cent of the 
proceeds are being used to provide 
food for families in need through 
Whole Foods and the Backpack 
Program at Hope High School. 
Books are on sale in the library on a 
donation basis. You pay what you 
can afford. Dig deep! 

The Friends of Rochambeau would 
like to thank Whole Foods, 
Chrissy,Thom, Helen, Eileen and all 
of the people who donated to this 
worthy cause.  Great job!!! ◘ 
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Please Join the Friends of Rochambeau   A 501(c)(3) non-profit organization 

 
 
Name _______________________________   Date______________ □ New Member        □ Current Renewal 
                    (1 month from renewal date) 
Address _________________________________________________     □ Data Update          □ Other 
 
City ____________________State ___________Zip______________      I enclose my tax-deductible ANNUAL membership 
         in the amount of : 
Email ___________________________ Phone __________________ 
         □ $500 Angel □ $250 Benefactor 
Comments _______________________________________________        □ $100 Patron □ $50 Sponsor 
         □ $25 BFF □ $20 Family Friends 
________________________________________________________        □ $10 Friends 
 
I’d like to help: □ Book Sale        

 □Other _______________________    
  □ I would like someone to contact me    
 

Please make your checks payable to: Friends of Rochambeau 
and mail to: Friends of Rochambeau Community Library, 708 Hope Street, Providence RI 02906         
  
E-mail the Friends at friend@friendsofrochambeau.org 
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